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1 Introduction 

This Step-by-step training guide relates to Ho Bay in the Grådyb tidal area located in 

western Jutland, Denmark. See Figure 1.2. 

 

 
 
Figure 1.1 The Grådyb tidal area, Denmark. View towards south with the island Langli in the 

foreground. Photo: Morten Pejrup 

 

 

 
 
Figure 1.2 Map of the Grådyb tidal area, which is located in the western part of Jutland, 

Denmark 
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1.1 Background 

Ho Bay is situated in the northernmost part of the European Wadden Sea forming the 

northern part of the Grådyb tidal area (Figure 1.2). This is a unique area with the Varde 

River being the only major waterway to the Wadden Sea, which has not been regulated or 

altered through straightening.  

 

The tidal estuary has a very dynamic morphology due to the significant and complicated 

sediment transport in the area. The surrounding widespread meadows constitute a very 

special type of nature. The meadows are flooded from time to time, and for the sections 

near the coast, the floods contain both saltwater and brackish water. This creates 

conditions for a very special flora and fauna. Because of these very particular natural 

conditions, the Varde River valley and the meadows around Ho Bay have attracted a 

great deal of attention, especially with regard to nature conservation.  

 

Today, the area is intensively cultivated, mainly for the production of dried fodder pellets 

from grass. This intensive type of production conflicts with the wish to preserve the natural 

ecosystems in the area.  

 

From a scientific point of view the area is also interesting, and therefore the area has 

been investigated with numerical models in several research projects.  

 

 
 
Figure 1.3 View of Varde River from Ho Bay, Denmark. Photo: Thorbjørn Joest Andersen 
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1.2 Objective 

The objective of this Step-by-step training guide is to set up a mud transport MIKE 21 

Flow Model with Flexible Mesh (MIKE 21 Flow Model FM Mud Transport Module) for the 

Grådyb tidal area from scratch and to calibrate the model to a satisfactory level. 

 

Attempts have been made to make this exercise as realistic as possible although some 

short cuts have been made with respect to the data input. This mainly relates to quality 

assurance and pre-processing of raw data to bring it into a format readily accepted by the 

MIKE Zero software. Depending on the amount and quality of the data sets this can be a 

tedious, but indispensable process. For this example the 'raw' data has been provided as 

standard ASCII text files. 

 

The files used in this Step-by-step training guide are a part of the installation. You can 

install the examples from the MIKE Zero start page. 

 

Please note that all future references made in this Step-by-step guide to files in the 

examples are made relative to the main folders holding the examples. 

 

User Guides and Manuals can be accessed via the MIKE Zero Documentation Index in 

the start menu. 

 

If you are familiar with importing data into MIKE Zero format files, you do not need to 

generate all the MIKE Zero input parameters yourself from the included raw data. All the 

MIKE Zero input parameter files required to run the example are included and the 

simulation can be initiated right away. 
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2 Creating the Computational Mesh 

Creation of the mesh file is a very important task in the modelling process. 

 

The mesh file couples water depths with different positions and contains the following 

information: 

 

1. Computational Grid 

2. Water Depths 

3. Boundary Information 

Creation of the mesh requires a xyz file(s) for positions of land-boundaries and a xyz 

file(s) that couples geographical positions with water depths. A dfs2 bathymetry can also 

be used as an alternative to an xyz file with water depths. 

 

Creation of the Computational Mesh typically requires numerous modifications of the data 

set, so instead of explaining every mouse click in this phase, the main considerations and 

methods are explained in the HD Step-by-step training guide, which can be accessed via 

the MIKE Zero Documentation Index in the start menu: 

 

MIKE 21 & MIKE 3 Flow Model FM, Hydrodynamic Module, Step-by-Step 

 

When creating the computational mesh you should work with the mdf file, which contains 

information about settings for the mesh. The focus in Step-by-step training guide is on 

Mud Transport, so both the necessary xyz files and the mdf file and a mesh file are 

already supplied with the example, so that the training time can be spent on specific Mud 

Transport subjects. 

 

The mesh that is used in the example is shown in Figure 2.1, and Figure 2.2 shows a 

graphical presentation of the mesh of the Grådyb tidal area as it can be displayed with 

MIKE Animator.  
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Figure 2.1 The Grådyb tidal area computational mesh as it can be presented with the Data 

Viewer tool 

 

 
Figure 2.2 The Grådyb tidal area computational mesh as it can be presented with the MIKE 

Animator tool 
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3 Creating the Input Parameters to the MIKE 21 Flow model FM 

Before the MIKE 21 Flow Model FM Mud Transport module can be set up, the input data 

must be generated from the measurements. The following measurements exist for year 

2004: 

 

1. Water levels at station Esbjerg Harbour, see Table 3.1 

2. Current measurements at station RCM9, see Table 3.1 

3. Turbidity measurements at station RCM9, see Table 3.1 

4. Wind measurements from Esbjerg, Denmark 

5. Wave model results of Blåvands Huk 

The measured raw data is included in the folder: 

 

.\Ho_Bay\Data\Ascii 

 

Preparation of input data is made by using various tools in MIKE Zero. Therefore 

reference is also made to the MIKE Zero User Guide, which can be accessed via the 

MIKE Zero Documentation Index in the start menu: 

 

MIKE Zero Pre- and Postprocessing, Generic Editors and Viewers, User Guide 

 

3.1 Generate Water Level Boundary Conditions 

Measured water level recordings from monitoring station Esbjerg Harbour are available 

for the Grådyb tidal area model, see Figure 3.1.  

 

The Grådyb tidal area model is forced with water level boundaries. Unfortunately, there 

are no measurements at the boundary, so the correct variation along the boundary is not 

known, and therefore the boundary is specified as a time series (dfs0 type file) constant 

along the boundary. An empirical method has been used to generate the water levels at 

the boundary based on the water levels measured in Esbjerg Harbour. The difference 

between the instant water levels and the average value of water levels in Esbjerg Harbour 

in the simulation period are multiplied by 110% and applied at the boundaries. The 

manipulated water levels at the boundary are also phase-shifted a half-hour forward in 

time relative to the water levels in Esbjerg Harbour to include the phase difference 

between the positions.  

 

The physical explanation of the above empirical approach is that it describes the phase 

difference and also the general loss of energy from the boundary to Esbjerg Harbour. This 

approach has successfully been used in previous studies in the area.  
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Figure 3.1 Map showing the positions of the water level station at Esbjerg Harbour, the current 

and turbidity monitoring station RCM9, and the source positions 

 

 
Table 3.1 Measurements in the Grådyb tidal area. Projection UTM-32 (datum WGS-84) 

 

Station Easting [m] Northing [m] ASCII file 

Esbjerg Harbour 464229 6145802 waterlevel_esbjerg.txt 

RCM9 461745 6148663 current_rcm9.txt 

turbidity_rcm9.txt 
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3.1.1 Importing measured water levels to time series file 

 

 
 
Figure 3.2 Starting the Time Series Editor in MIKE Zero 

 

Open the Time Series Editor in MIKE Zero (File → New → MIKEZero → Time Series), 

see Figure 3.2. Select the ASCII template. Open the text file waterlevel_esbjerg.txt 

(Figure 3.3). Change the time description to 'Non-equidistant Calendar Axis' and press 

OK, see Figure 3.4. Save the data in waterlevel_esbjerg.dfs0 and the Time Series Editor 

will show the imported water levels from station Esbjerg Harbour (Figure 3.5). 

 

 
 
Figure 3.3 ASCII file with water level recordings from station Esbjerg Harbour 



 MIKE 21 Flow Model FM 

10 Mud Transport Module - © DHI A/S 

 
 
Figure 3.4 Time Series Editor Import Template 

 

 

 
 

Figure 3.5 Time Series Editor with imported Water Levels from station Esbjerg Harbour 
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To make a plot of the water level time series open the Plot Composer in MIKE Zero, see 

Figure 3.6. Select 'plot' → 'insert a new plot object' and select 'Time Series Plot' (see 

Figure 3.7).  

 

 
 
Figure 3.6 Starting the Plot Composer in MIKE Zero 

 

 

 
 
Figure 3.7 Insert a new Plot Object as Time Series in Plot Composer 
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Right click on the plot area and select properties. Add the actual time series file to the Plot 

Composer by clicking  and selecting the file, see Figure 3.9. It is possible to add more 

than one time series to the same plot. In the property dialogue it is possible to change 

some of the properties for the plot, such a colours, etc. (see Figure 3.8). 

 

 
 
Figure 3.8 Plot Composer Time Series Plot Properties dialogue for selecting time series files and 

adjusting scales, curves, etc. 
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Figure 3.10 shows the measured water levels in Esbjerg Harbour. 

 

 
 
Figure 3.9 Selection of time series files in the Plot Composer 

 

 

 
 
Figure 3.10 Time series of water levels in the Esbjerg Harbour as it can be viewed with the Plot 

Composer tool 
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3.1.2 Creating boundary conditions 

The next step is to create the boundary water level time series from the generated time 

series in Esbjerg Harbour. Open the MIKE Zero Toolbox time series interpolation tool: 

New → MIKE Zero Toolbox → Time series → Interpolate Time Series, see Figure 3.11 

and Figure 3.12.  

 

Please note that time series must have equidistant time steps in the present version of 

MIKE 21 & MIKE 3 Flow Model FM. That means if the raw data has a Non-equidistant 

Calendar Axis, it must be converted to Equidistant Calendar Axis first before applying it as 

model input. Therefore we start by creating a time series similar to the one we created in 

Section 3.1.1, but with Equidistant Calendar Axis.  

 

 
 
Figure 3.11 Starting the MIKE Zero Toolbox in MIKE Zero 
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Figure 3.12 Starting the Tool for Interpolating Time Series 

 

 

Follow the tutorial and specify the input file name: waterlevel_esbjerg.dfs0 on the first 

page. On the next page choose 'Linear' interpolation method, and select a time interval of 

1800 seconds. 

 

Finally, specify output file name for the new interpolated time series file. Save it as:  

 

'.\Ho_Bay\Data\Boundary_Conditions\waterlevel_west.dfs0' 

 

On the final page you click , and the new time series with Equidistant 

Calendar Axis will be generated. 

 

Open waterlevel_west.dfs0. Find the average value for the simulation period: 

 

15-4-2004 to 22-4-2004 

 

Go to: Tools → Statistics. Specify the period in the Sub-series dialogue. Go to the 

Statistics dialogue and read the mean value: -0.118635 m, see Figure 3.13. 
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Figure 3.13 Statistics Tool for Time Series: Reading mean value of water levels in Esbjerg 

Harbour in the period 15-4-2004 to 22-4-2004: -0.12 m 
(-0.118635 m) 

 

 

Go to: Tools  → Calculator 

 

Add 0.118635 m to the time series, see Figure 3.14.  

 

 
 
Figure 3.14 Calculator Tool for Time Series: Adding 0.118635 to the Time Series 

 

Next you should use the calculator to multiply the time series by 1.1:  

 

i1=i1*1.1 

 

Afterwards you should subtract 0.118635 m again with the calculator.  
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Finally, the time series should be phase-shifted by ½ hour. You do that by marking row 1 

(4/1/2004 12:30) to row 2928 (6/1/2004 00:00) with the mouse. Then type Ctrl+C and click 

row 0 (4/1/2004 00:00), type Ctrl+V.  

 

The time series has now been adjusted and can be used as boundary condition for the 

western boundary. The difference between the measurements in Esbjerg Harbour and the 

manipulated time series at the boundary can be seen in Figure 3.15. 

 

 

 
 
Figure 3.15 Comparison of water levels at Esbjerg Harbour and at the Western Boundary 

 

3.2 Initial Conditions 

The initial surface level is estimated the same as the measured in Esbjerg Harbour at the 

beginning of the simulation. Check the measured time series file for Esbjerg Harbour. We 

will use 0.17 m as constant value for the whole domain as initial condition for the water 

levels.  
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3.3 Wind Forcing 

Wind recordings from Esbjerg Harbour will form the wind forcing as time series constant 

in space. Load the Time Series Editor and import the ASCII file 'wind_esbjerg.txt' (Figure 

3.16) with the equidistant calendar axis. Save the file in 'wind_esbjerg.dfs0'. Time series 

of the wind speed and direction are shown in Figure 3.17. 

 

 
 
Figure 3.16 ASCII file with wind speed and direction from Esbjerg Harbour 

 

 

 
 
Figure 3.17 Wind speed and direction from Esbjerg Harbour, as it can be illustrated in the Plot 

Composer (Time Series Direction plot control) 
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A more descriptive presentation of the wind can be given as a wind speed (or wind rose) 

diagram. Start the 'Plot Composer' insert a new plot object, and select 'Wind/Current Rose 

Plot' and then select properties and select the newly created file 'wind_esbjerg.dfs0' and 

change the properties of the plot as you prefer with respect to appearance (colours, etc.). 

The result is shown in Figure 3.18. 

 

 
 
Figure 3.18 Wind rose from Esbjerg Harbour as it can be illustrated in the Plot Composer. The 

dominating wind direction is northwest 

 

3.4 Generate Manning Number Data 

From a previous MIKE 21 modelling study, it has been suggested that the Manning 

Number should have a depth dependent distribution in the Grådyb tidal area. So the 

Manning Number has the value 35 [
13

1
− sm ] in the deeper parts of the Bay and 45 [

13
1

− sm ] in the rest. 

 

In this example, all the data are given as an ASCII file (manning_number.txt) containing 

data, which shall be imported to a dfs2 file with the Grid Series Editor (see Figure 3.19, 

Figure 3.20, Figure 3.21 and Figure 3.22):  

 

New → Grid Series → From Ascii File → Select file name 
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Figure 3.19 Starting to create a new Grid series 

 

 

 
 
Figure 3.20 Creating dfs2 file from an ASCII file 
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Figure 3.21 Specifying the ASCII file to import for creation of dfs2 file 

 

 

 
 
Figure 3.22 Manning number distribution in the Grådyb tidal area, given in the file 

manning_number.dfs2 

 
  



 MIKE 21 Flow Model FM 

22 Mud Transport Module - © DHI A/S 

3.5 Generate Source Data 

3.5.1 Hydrodynamic source discharges 

There are 3 sources in the Grådyb tidal area model domain: water discharge from Varde 

River and also sediment discharge at two artificial dumpings. The best thing is to get the 

source data as frequent measurements of discharge, or as model results of the stream in 

question, but sometimes no data exists and you have to make estimates of the 

discharges in a stream or other source. In this case there are measurements of the 

discharge flows in Varde River. The raw data is supplied in the ASCII file: 

 

varde_river_discharge.txt  

 

which can be found in the folder: 

 

.\Ho_Bay\Data\Ascii 

 

Generate the source file with the Time Series Editor by importing the ASCII files and 

saving it as: 

 

.\Ho_Bay\Data\\Sources\varde_river_discharge.dfs0 

 

The annual cycle of flow in Varde River is illustrated in Figure 3.23. 

 

 
 
Figure 3.23 Annual cycle of discharge in Varde River in year 2004 

 

 

The discharge from the sediment dumping discharge is fictive, because the loading of 

mass is actually dry without a real hydrodynamic discharge. We have chosen to use a 

discharge of 0.001 m3/s.  
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3.5.2 Suspended sediment source concentrations 

The concentration in Varde River of sediment in suspension must also be specified. No 

measurements are available, so we will use a constant concentration 0.01 kg/m3. 

 

Based on the data for M and discharge Q (see Section 3.5.1), the sediment concentration 

C can be estimated as: C=M/Q. 

 

The mass flux M of 'Fraction 1 mud concentrations' in the dumping sources is measured. 

For dumping location E and F the data is available in the ASCII file: 

 

. \Ho_Bay\Data\Ascii\dumping_mass.txt. 

 

Import the ASCII file with the Time Series Editor. Save the file as: 

 

.\Ho_Bay\Data\Sources\sediment_dumping.dfs0.  

 

Go to: Tools → Calculator 

 

Divide the mass flux with the discharge: 0.001 m3/s. Now the discharge [m3/s] and the 

mass flux have been used to estimate a corresponding concentration [kg/m3] in the file 

sediment_dumping.dfs0. 

 

The time series of the mass flux from the dumping E and F can be seen in Figure 3.24. 

 

 
 
Figure 3.24 The time series of mass flux of dumped sediment [kg/s] at location E and F 
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3.6 Generate Mud Transport Model Constant Parameters 

The Mud Transport model is flexible with respect to how many mud fractions and 

sediment layers the model shall consist of.  

 

The choice of number of mud fractions is based on considerations regarding  

 

1. computation time 

2. user wishes for the specific fractions 

3. available data 

In this example, the data is only supporting 1 fraction, and there is not a user wish to 

simulate specific fractions, so only 1 fraction will be applied. 

 

The choice of number of sediment layers is based on considerations regarding: 

 

1. computation time 

2. length of simulation and how dynamic the morphology in the area is 

3. available data 

In this example, the model will consist of 1 fraction of mud and 2 sediment layers. The top 

layer of the sediment (Layer 1) is considered to be soft mud, and Layer 2 is considered to 

be more consolidated mud. When only simulating 1 week it is assumed that 2 layers are 

enough. 

3.6.1 Critical shear stress for consolidated mud in layer 2 

The critical shear stress is an important factor that influences the resuspension of 

sediment. The value for critical shear stress depends on how consolidated and dense the 

sediment is. It is a parameter for calibration. From another study data exists that contain 

the spatial distribution of critical shear stress in layer 2 in the Grådyb tidal area.  

 

Generate a dfs2 file from the ASCII file: 

 

critical_shear_stress_layer2.txt  

 

with the Grid Series Editor, and save the file as: 

 

critical_shear_stress_layer2.dfs2  

 

This generated dfs2 file can be used directly in this study, see Figure 3.25.  
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Figure 3.25 Critical Shear stress for Layer 2 sediments [N/m2] 

 

3.7 Generate Wave Data 

Waves can have an impact on the sediment transport in an area. There are two methods 

for inclusion of waves in the simulation. Both require that you have a result file from a 

wave model of the area. It is required that the wave result file contains data of wave 

heights, wave periods, and wave directions. You can directly specify a result file of a 

MIKE 21 SW (Spectral Wave) model of the area, or you can analyse the wave result file 

regarding wind and water level and generate a database with pictures of typical wave 

patterns for different wind situations and different water levels. The first method means 

that during simulation the wave result file is read. The second method requires that the 

area is dominated by wind-waves, and that the waves respond quickly to a change in 

water level, wind speed and direction. The latter method will save hard disk space, 

because it will interpolate the typical pictures of wave variables with respect to actual wind 

conditions and water levels during simulation.  

 

In this example we will use the database method. 

 

Run the wave model with artificial wind covering 4 directions and a wind speed of 5 m/s 

and 15 m/s. Run with static boundary conditions, so that a situation with water levels 

around –1 m is obtained. For each situation you should save an output file. Repeat the 

exercise with a water level of 2 m.  
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3.7.1 Wave database 

This exercise has already been done and the 16 wave output files are ready to use in the 

example, see the list of files in Table 3.2. 

 

 
Table 3.2 List of wave output files for different wind direction, wind speeds, and water levels 

 

Wind direction Wind speed 

[m/s] 

Water level 

[m] 

File name 

N 5 -1 n5--1.dfsu 

N 5 2 n5-2.dfsu 

N 15 -1 n15--1.dfsu 

N 15 2 n15-2.dfsu 

E 5 -1 e5--1.dfsu 

E 5 2 e5-2.dfsu 

E 15 -1 e15--1.dfsu 

E 15 2 e15-2.dfsu 

S 5 -1 s5--1.dfsu 

S 5 2 s5-2.dfsu 

S 15 -1 s15--1.dfsu 

S 15 2 s15-2.dfsu 

W 5 -1 w5--1.dfsu 

W 5 2 w5-2.dfsu 

W 15 -1 w15--1.dfsu 

W 15 2 w15-2.dfsu 

 

 

Each picture (dfsu file) illustrates typical wave patterns that can be expected at specific 

wind and water level conditions, see Figure 3.26. 
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Figure 3.26 Example from database of wave height in situation with easterly wind of 5 m/s and a 

water level of 1 m 

 

3.8 Generate Mud Transport Model Initial Conditions 

The initial conditions are very important in a short simulation as used in this example. At 

the same time they are difficult to measure and estimate correctly, and therefore, a 

difficult part of a Mud Transport Model to define. The following iterative approach is often 

used to estimate the initial conditions: 

 

1. The initial conditions are first based on sedimentological maps of the area.  

2. Afterwards some test model simulations indicate where deposition can take place.  

3. From these results the maps are adjusted.  

This exercise has already taken place in another study of the area. A first guess of a set 

of initial condition files are therefore already supplied for the first calibration simulation 

with this example as dfs2 files: 

 

1. Fraction 1 mud concentration: mt_version1.dfs2 (item 1) 

2. Layer 1 thickness: mt_version1.dfs2 (item 2) 

3. Layer 2 thickness: mt_version1.dfs2 (item 3) 

Initial conditions must be specified for 'Fraction 1 mud concentrations', and 'Thickness of 

Layer 1 and Layer 2'. 

 

The supplied dfs2 files are shown in Figure 3.27, Figure 3.28, and Figure 3.29. The files 

can be generated from the corresponding ASCII files included in the example using the 

Grid Series Editor. 
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Fraction 1 

 
 
Figure 3.27 Initial condition for Fraction 1 mud concentrations [kg/m3] 

 

Layer 1 

 
 
Figure 3.28 Thickness of Layer 1, initial condition given as dfs2 file [mm] 
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Layer 2 

 
 
Figure 3.29 Thickness of Layer 2, initial condition given as dfs2 file [m] Set-Up of MIKE 21 Flow 

Model FM 
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4 Specifications for the MIKE 21 Flow Model FM 

We are now ready to create the specification file for the Mud Transport modelling using 

the Grådyb tidal area mesh with year 2004 input data as generated in Chapter 3. Initially 

we will use the default parameters and not take into account the effect of the density 

variation at the boundaries. The set-up in the first calibration simulation consists of the 

parameters shown in Table 4.1. 

 

 
Table 4.1 Specifications for the calibration simulation 

 

Parameter Value 

Specification File ho.m21fm 

Mesh and Bathymetry ho.mesh    3266 Nodes 

Simulation Period 2004-04-15 00:00 – 2004-04-22 00:00 (7 days) 

Time Step Interval 60 s 

No. of Time Steps 10080 

HD: Solution Technique Low order, fast algorithm 

Minimum time step: 0.01 s 

Maximum time step: 60 s 

Critical CFL number: 0.8 

HD: Enable Flood and Dry Yes 

HD: Initial Surface Level 0.2 m 

HD: Wind Varying in time, constant in domain: 

wind_esbjerg.dfs0 

HD: Wind Friction Constant: 0.001255  

HD: North and West 

Water level Boundary  

Type 0 data: waterlevel_west.dfs0 

HD: Eddy Viscosity Smagorinsky formulation, Constant 0.28 m1/3/s 

HD: Resistance Manning number. Varying in domain: 

manning_number.dfs2 

MT: Number of Fractions 1 

MT: Number of Layers 2 

MT: Settling 

Settling velocity coefficient 

5 m/s 

MT: Erosion: 

Critical Shear Stress layer 2 

Varying in domain: 

critical_shear_stress_layer2.dfs2 

MT: Bed Roughness 0.001 m 

MT: Initial Cond. Fraction 1 

MT: Initial Cond. Layer 1 

MT: Initial Cond. Layer 2 

Varying in domain: mt_version1.dfs2, item 1 

Varying in domain: mt_version1.dfs2, item 2 

Varying in domain: mt_version1.dfs2, item 3 

MT: Include waves 

Shear stress formulation 

Yes, database specification 

Max Soulsby 

Result Files hd.dfsu       esbjerg_hd.dfs0      rcm9_hd.dfs0    

mt.dfsu       rcm9_mt.dfs0 
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In the following screen dumps, the individual input pages are shown and a short 

description is provided. 

 

Additional information about the Mud Transport Module can be found in the MIKE 21 Flow 

Model FM Mud Transport Module User Guide in the Manuals folder.  

 

4.1 Basic Parameters 

Specify the bathymetry and mesh file ho.mesh in the Domain dialogue, see Figure 4.1. 

The projection zone has already been specified in the mesh as UTM-32. In the mesh file, 

each boundary has been given a code, see Figure 4.3. In this Grådyb example the West 

Boundary has 'Code 2' and the North Boundary has 'Code 3'. Rename the boundary 

'Code 2' to 'West' and 'Code 3' to 'North' in the dialogue Boundaries window, see Figure 

4.2.  

 

 
 
Figure 4.1 MIKE 21 Flow Model FM: Specify Domain 
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Figure 4.2 M21 Flow Model FM: Renaming boundaries 

 

 

 
Figure 4.3 In the Data Viewer it is also possible to view the code values of the boundaries 
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Specify the overall time step in the 'Time' dialogue to 60 s. The time step range must be 

specified to 10080 time steps in order to simulate a total period of 7 days. See Figure 4.4. 

 

 
 
Figure 4.4 MIKE 21 Flow Model FM: Simulation period 

 

Include the 'Mud Transport Module' in the 'Module Selection' dialogue, see Figure 4.5.  

 

In this example, the Hydrodynamic Module and the Mud Transport Module will be used.  

 

 
 
Figure 4.5 MIKE 21 Flow Model FM: Module Selection 
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4.2 Hydrodynamic Module 

The shallow water equations are solved using 'Low order, fast algorithm' for both time 

integration and space integration, see Figure 4.6. 

 

The minimum time step is set to 0.01 to ensure that the CFL number always is lower than 

the critical CFL number, here defined as 0.8. The maximum time step is set to the overall 

time step of 60 s. 

 

 
 
Figure 4.6 MIKE 21 Flow Model FM: Solution Technique 

 

In this example the flooding and drying should be included, because many areas in the 

Grådyb tidal area will dry out during the simulation. If you choose not to include flooding 

and drying, the model will blow up in situations with dry areas. 

 

In the 'Flood and Dry' dialogue it is possible to include flood and dry, see Figure 4.7. In 

our case select a Drying depth of 0.005 m and a Wetting depth of 0.1 m. These are 

default values. 

 

As the density variation is not taken into account in this example the density should be 

specified as 'Barotropic' in the 'Density ' dialogue, see Figure 4.8. 
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Figure 4.7 MIKE 21 Flow Model FM: Flood and Dry 

 

 

 
 
Figure 4.8 MIKE 21 Flow Model FM: Density specification 

 

The default setting for the Horizontal Eddy Viscosity is a Smagorinsky formulation with a 

coefficient of 0.28, see Figure 4.9.  
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Figure 4.9 MIKE 21 Flow Model FM: Eddy Viscosity (Horizontal) 

 

The Bed Resistance will be given as a map with Manning numbers varying in the domain, 

see Figure 4.10. Use the format 'Varying in domain' and specify the dfs2 file 

‘manning_number.dfs2’ that was generated earlier. 

 

Coriolis is most often included in real applications. Only for laboratory type of simulations 

Coriolis is most often ignored, see Figure 4.11. 
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Figure 4.10 MIKE 21 Flow Model FM: Bed Resistance 

 

 

 
 
Figure 4.11 MIKE 21 Flow Model FM: Coriolis Forcing 
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To use the generated wind time series specify it as 'Variable in time, constant in domain' 

in the Wind Forcing dialogue, and locate the time series wind_esbjerg.dfs0.  

 

Please note that an easy way to see the wind data file is to simply click  in the 

Wind Forcing dialogue, see Figure 4.12. 

 

 

 
 
Figure 4.12 MIKE 21 Flow Model FM: Wind Forcing 

 

It is a good practice to use a soft start interval. In our case 7200 s is suggested. The soft 

start interval is a period at the beginning of a simulation where the effect of the wind does 

not take full effect. At the beginning of the soft start period the effect of the specified Wind 

Forcing is zero and then it increases gradually until it has full effect on the model at the 

end of the soft start interval period. Specify the Wind Friction type as 'Constant' and use 

the default values for the Wind Friction: 0.001255. See Figure 4.13. 
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Figure 4.13 MIKE 21 Flow Model FM: Wind Friction 

 

 

In this example 

 

• Ice Coverage is not included  

• Precipitation-Evaporation is not included 

• Wave Radiation is not included 

• Tidal Potential is not included 

and their dialogue pages are not explained. 

 

The discharge and velocity for each source and sink should be specified in the 'Sources' 

dialogue. There are 3 sources in this example: Varde River, Dumping E and Dumping F. 

Varde River is specified with a time series discharge, and the two dumping sources with 

constant discharges of 0.001 m3/s. See Figure 4.14. 
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Figure 4.14 MIKE 21 Flow Model FM: Sources 

 

The location of the sources must also be specified. Use the coordinates in Table 4.2. 

 

 
Table 4.2 Position of sources (UTM-32) 

 

Source Easting Northing Discharge 

Varde River 457607 6159684 varde_river_discharge.dfs0 

Dumping position E 461771 6148416 0.001 m3/s 

Dumping Position F 464646 6145524 0.001 m3/s 

 

 

When you have specified the source coordinates, you should see a graphical map 

indicating the positions of the sources, cf. Figure 4.15. 

 

Now you should check the boundary conditions at the simulation start time to estimate the 

initial surface level. In this case we will use a constant level of 0.2 m, which is the 

measured value in Esbjerg harbour at the start of the simulation, see Figure 4.16. 
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Figure 4.15 MIKE 21 Flow Model FM: Position in domain of specified sources 

 

 
 
Figure 4.16 MIKE 21 Flow Model FM: Initial Conditions 

 

In the Boundary Conditions dialogue, the boundary conditions should be specified for the 

boundary names, which were specified in the Domain dialogue. There is a North 
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Boundary and a West Boundary, and the time series that were generated in Chapter 3 

should be used on both boundaries.  

 

In this example the boundary type is 'Specified Level' (Water Level), because only Water 

Level measurements are available. 'Specified Level' means that the Water Levels are 

forced at the boundaries, and the discharge across the boundary is unknown and 

estimated during simulation.  

 

The boundary format must be set as 'Varying in time, constant along boundary' in order to 

specify the boundary as a time series file (dfs0). 

 

Click  and select the appropriate data file in the Open File window that appears, 

see Figure 4.17. 

 

 
 
Figure 4.17 MIKE 21 Flow Model FM: Boundary Select File 

 

For the North Boundary select the waterlevel_west.dfs0, and also for the West Boundary 

select waterlevel_west.dfs0. The files are the same because the water levels are 

assumed to be the same along the two boundaries. 
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Use a soft start interval of 7200 s and a reference value corresponding to the initial value 

of 0.2 m. The soft start interval is a period in the beginning of a simulation where the 

effect of the boundary water levels does not take full effect. At the beginning of the soft 

start period the effect of the specified Boundary Condition is zero. The effect increases 

gradually until the boundaries have full effect in the model at the end of the soft start 

interval period. See Figure 4.18.  

 

Please note that an easy way to see the boundary data file is to simply click  in 

the Boundary dialogue. 

 

 
 
Figure 4.18 MIKE 21 Flow Model FM. The Boundary Conditions for the West Boundary are 

specified as constant along the boundary: waterlevel_west.dfs0 

 

Then you may specify one output as an area series (2D) and also specify the resulting 

output file name, see Figure 4.19. Specify the file name hd.dfsu for the first simulation. 

Make sure the required disk space is available on the hard disk. Reduce the output size 

for the area series to a reasonable amount by selecting an output frequency of 3600 s, 

which is a reasonable output frequency for a tidal simulation. As our time step is 60 s then 

the specified output frequency is 3600/60 = 60. As default, the full area is selected. 
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Figure 4.19 MIKE 21 Flow Model FM: Results can be specified as point, line or area series 

 

 

Pick the parameters to include in the output file as in Figure 4.20. 

 

 
 
Figure 4.20  MIKE 21 Flow Model FM: Output Parameters 

 

Also specify an output file as point series at the monitoring stations in RCM9 and Esbjerg 

Harbour, see the positions in Table 4.3. You might consider saving other time series from 

neighbouring points, so that you can see how much the results vary in the area near the 

monitoring station.  
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4.3 Mud Transport Module 

The next step is to select the parameters for the specific Mud Transport Model.  

 

The following features are not included in this example: 

 

1. Sand fractions 

2. Transition between layers  

3. Dredging 

4. Morphology 

In the Parameter Selection dialogue, you must specify how many particle size fractions 

and mud bed layers that the model shall contain, see Figure 4.21.  

 

It is possible to include up to 8 fractions and up to 12 sediment layers. So there are 

actually 96 possible combinations. For this example, please select 1 fraction and 2 

sediment layers. 

 

 
 
Figure 4.21 MIKE 21 Flow Model FM: Parameter Selection in the Mud Transport dialogue 

 

The solution technique defined in the next dialogue is set to the same as for the 

hydrodynamic calculations, namely 'Low order, fast algorithm'. 

 

The water column parameters must be specified in a way, so that properties relating to 

processes in the water column can be covered, i.e. settling and deposition. 

 

In the Settling dialogue the general settling properties and the specific settling properties 

of each particle size fraction (in this case only one) must be specified. Flocculation should 

be included with a flocculation criteria of 0.01 kg/m3, which means that flocculation as a 

function of suspended sediment concentration will start when SSC>0.01 kg/m3. See 

Figure 4.22. The sediment density is specified as 2650 kg/m3. 

 

The settling velocity coefficient must also be specified. As only one fraction is modelled it 

must cover a range of grain sizes. 

 

As flocculation is included, the settling velocity of the suspended sediment is not given 

directly, but as a coefficient from which the actual settling velocity will be derived. We will 

use the default value of 5 m/s for Fraction 1 mud concentrations specified with a constant 

format, see Figure 4.23.  
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Figure 4.22 MIKE 21 Flow Model FM: Specification of settling properties in the Mud Transport 

dialogue 

 

 

 
 
Figure 4.23 MIKE 21 Flow Model FM: Settling velocity coefficient in the Mud Transport dialogue 

 

 

Please note that the magnitude of a Settling Velocity Coefficient is not directly 

comparable with Settling Velocity, because factors are multiplied by the coefficient to 

estimate the resulting settling velocity.  
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In order to describe the distribution of suspended matter in the water column, a profile 

equation must be picked: 

 

1. Teeter Profile 

2. Rouse Profile 

We will use the default Teeter profile. The Critical Shear Stress for Deposition uses the 

default value 0.07 N/m2, see Figure 4.24 and Figure 4.25.  

 

 
 
Figure 4.24 MIKE 21 Flow Model FM: Deposition specification in the Mud Transport dialogue 

 

 

 
 
Figure 4.25 MIKE 21 Flow Model FM: Specifying Critical Shear Stress for deposition for of 

Fraction 1 suspended matter in the Mud Transport dialogue 

 

The Bed Parameters must be specified, so that properties relating to processes in the 

sediment layers may be described including erosion and density of the layers. 
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For erosion the maximum concentration allowed due to erosion is specified as 50 kg/m3. 

See Figure 4.26. If the limit is reached the erosion process stops. 

 

 
 
Figure 4.26 MIKE 21 Flow Model FM: Erosion specification in the Mud Transport dialogue 

 

Select the erosion description as ‘Soft mud’ for layer 1 and ‘Hard mud’ for layer 2. 

 

Set ‘Alpha coefficient’ to 8.3 for layer 1 and ‘Power of erosion’ to 1 for layer 2. 

 

For each layer the erosion coefficient must be specified. Use a constant value of 0.00005 

kg/m2/s in layer 1 and layer 2. See Figure 4.27. 

 

 
 
Figure 4.27 MIKE 21 Flow Model FM: Erosion parameters for Layer 2 in the Mud Transport 

dialogue 

 

For layer 1 the critical shear stress is specified as constant with a value of 0.1 N/m2 and 

for layer 2 it is constant with a value of 0.3 N/m2. 
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The density of the sediment layers must also be specified. The more consolidated, the 

denser the layers are. For Layer 1 specify a density of 180 kg/m3, and for the denser layer 

2 a density of 300 kg/m3. See Figure 4.28. 

 

 
 
Figure 4.28 MIKE 21 Flow Model FM: Specifying density for Layer 1 in the Mud Transport 

dialogue 

 

Set the bed roughness as constant with a value of 0.001 m, see Figure 4.29. 

 

 
 
Figure 4.29 MIKE 21 Flow Model FM: Specifying Bed Roughness 
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Forcings include the impact from waves. These shall be included with a database with 16 

wave patterns representing different wind and water level conditions. MIKE 21 Flow 

Model FM Mud Transport Module interpolates the patterns during simulation with respect 

to simulated water levels and the wind conditions based on the wind file given in Chapter 

3.3. There are 2 wind speed situations, 4 wind direction situations, and 2 water level 

situation. Thus, they can be combined in 16 different ways. The files to specify are shown 

in Table 3.2. 

 

The minimum water depth is set to 0.1 m and the shear stress formulation is selected as 

Max (Soulsby), see Figure 4.30.  

 

 
 
Figure 4.30 MIKE 21 Flow Model FM: Specifying the Wave database parameters in the Mud 

Transport dialogue 

 

The dispersion properties are specified with a scaled eddy viscosity formulation using a 

scaling factor of 1. See Figure 4.31. 

 



 MIKE 21 Flow Model FM 

52 Mud Transport Module - © DHI A/S 

 
 
Figure 4.31 MIKE 21 Flow Model FM: Dispersion coefficient specifications in the Mud Transport 

dialogue 

 

 

The source concentrations of Fraction 1 suspended matter must be specified, see Figure 

4.32. For Varde River the concentration is not known, but use an estimate of a constant 

concentration 0.01 kg/m3.  

 

For the dumping sources specify the time series related to the time series generated in 

Chapter 3.5: 

 

Dumping position E:  sediment_dumping.dfs0 item 1 

Dumping position F:  sediment_dumping.dfs0 item 2 

 

Please note that a shortcut to see the location of the source is to click ‘View location ...’  
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Figure 4.32 MIKE 21 Flow Model FM: Specifying Mud concentrations of Fraction 1 in sources in 

the Mud Transport dialogue 

 

Initial conditions for Fraction 1 concentration and the thickness of the sediment layers 

must be specified. Use the dfs2 file that was generated in Chapter 3: 

 

Fraction 1 concentration: mt_version1.dfs2  item1 

Layer 1 thickness: mt_version1.dfs2  item2 

Layer 2 thickness: mt_version1.dfs2  item3 

 

See Figure 4.33 and Figure 4.34. 
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Figure 4.33 MIKE 21 Flow Model FM: Specifying initial conditions for the Fraction 1 mud 

concentrations in the Mud Transport dialogue 

 

 

 
 
Figure 4.34 MIKE 21 Flow Model FM: Specifying initial condition of Layer 2 thickness in the Mud 

Transport dialogue 
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The Boundary concentration of suspended matter must be specified for Fraction 1 

concentrations. Use an estimate of 0.004 kg/m3. Also specify a soft start of 7200 s. See 

Figure 4.35. 

 

 
 
Figure 4.35 MIKE 21 Flow Model FM: Specifying boundary conditions for the Fraction 1 mud 

concentrations in the Mud Transport dialogue 

 

Finally, the output files must be specified. See Figure 4.36, and Figure 4.37. 

 

You should save 2 output files:  

 

• a 2D area series representing the whole domain  

• a time series at the monitoring station RCM9  
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Figure 4.36 MIKE 21 Flow Model FM: Specifying output file in the Mud Transport dialogue 

 

 
 
Figure 4.37 MIKE 21 Flow Model FM: Specifying an Area Series output file in the Mud Transport 

dialogue 

 

Now we are ready to run the MIKE 21 Flow Model FM. (Run → Start simulation…). 
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The specification file for this example has already been made: 

 
.\Ho_Bay\Calibration_1\Ho.m21fm 

 

Please note that if you experience an abnormal simulation, you should look in the log file 

to see what causes the problem. The log file is displayed in the lower simulation window 

of the main GUI, but is also accessible from a list in the file drop-down menu 'File → 

Recent log files'. 

 

After the simulation is finished, use the Plot Composer (or Data Viewer) to inspect and 

present the results. 

 

The simulation data can be manipulated and extracted directly from dfsu result files by 

use of the Data Manager or the Data Extraction FM tool: 

 

New → MIKE Zero → Data Manager 

New → MIKE Zero → Data Extraction FM 

 

The Post Processing Tools (data extraction, statistics, etc.) developed for the dfs2 and 

dfs3 formats can also be used for dfsu files. It requires a conversion of the dfsu file to a 

dfs2 or dfs3 file first. There is a tool available for that conversion: 

 

New → MIKE Zero → Grid Series → From Dfsu File 

 

4.4 Model Calibration 1 

4.4.1 Measured values 

In order to calibrate the model some measurements are required inside the model 

domain. Measurements of water level, current velocities and turbidity are available, see 

Table 4.3.  

 
Table 4.3 Measurements in the Grådyb tidal area. Projection UTM-32 (datum WGS-84) 

 

 

Station 

 

Data Files 

Position 

Easting 

(m) 

Northing 

(m) 

Esbjerg waterlevel_esbjerg.txt 464229 6145802 

RCM9 turbidity_rcm9.txt 

current_rcm9.txt 

461745 6148663 

 

Measurements of water levels are given at Esbjerg Harbour (waterlevel_esbjerg.txt). 

Import this ASCII file using the Time Series Editor (how to import ASCII files to time 

series, see Section 3.1.1).  

 

The water level at Esbjerg is shown in Figure 4.38. 
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Figure 4.38 Esbjerg Harbour: Measured water levels  

 

Measurements of current speed are given for station RCM9 (currents_rcm9.txt). Import 

this file with the Time Series Editor.  

 

A plot of measured current speed and direction is shown in Figure 4.39. 

 

 
 
Figure 4.39 Station RCM9: Measured current speed and direction 

 

The turbidity has been measured 4 metres above the seabed (approximately in the middle 

of the water column), so the depths of the measurements vary with the tides from 2 m to 

5.2 m. The measurements are compared directly with the results from the depth-

integrated model.  

 

This means that a vertical profile is assumed with an average value 4 metres above the 

seabed. This is of course an approximation to the real conditions. 

 

Measurements of turbidity are given for station RCM9 (turbidity_rcm9.txt). 

 

Import this file with the Time Series Editor. A plot of measured turbidity is shown in Figure 

4.40. 
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Figure 4.40 Station RCM9: Measured turbidity [kg/m3] 

 

4.4.2 Compare model result and measured values 

Use the Plot Composer to plot the simulated and measured water levels, currents and 

turbidity.  

 

For this example, Plot Composer files have already been made. The files are found in the 

following folder: 

 

.\Ho_Bay\Calibration_1\Plots 

 

In order to see a comparison of measurements and model output of water levels at 

Esbjerg Harbour and current velocity and turbidity at station RCM9 you need to open the 

following files:  

 

1. waterlevel_esbjerg.plc 

2. current_speed_rcm9.plc 

3. turbidity_rcm9.plc 

If your simulation is successful, plots as shown in Figure 4.41, Figure 4.42, and Figure 

4.43 will appear. 
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Figure 4.41 Comparison of measurements and model output of water levels at Esbjerg Harbour, 

Calibration 1 

 

 

 
 
Figure 4.42 Comparison of measurements and model output of currents at monitoring station 

RCM9, Calibration 1 
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Figure 4.43 Comparison of measurements and model output of turbidity at monitoring station 

RCM9, Calibration 1 

 

The comparisons between measured and calculated water levels and current speed 

indicate that the calibration is good for the hydrodynamic conditions.  

 

Therefore, for the hydrodynamic results we will not calibrate further. 

 

The comparison of measured and simulated values of turbidity (Figure 4.43) shows that 

the simulated values are reasonable in the beginning of the calculation but decrease too 

much as the simulation continues. Also, it seems that the additional mud, which was 

dumped during the last two days of the simulation - and probably contributed to the 

increased turbidity in the measurements at the end of the period – is not giving any effect 

in the modelled data. This result can be improved by calibration. 

 

The dominance of the tidal cycle in turbidity during the simulation indicates that the basic 

physical processes of the sediment (settling and resuspension) are not resolved correctly 

by the parameters. 

 

Calibration simulations concerning various parameters are given in the following sections. 
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4.5 Model Calibration 2 

4.5.1 Generate decoupled model data 

The first simulation showed that the hydrodynamic results need no further calibration. 

However, it can save time in future calibration runs if the basic flow information is read 

from a file instead of calculating the flow information during the simulation. This is 

possible when running a simulation in decoupled mode. 

 

First, you need to generate the decoupling data.  

 

The decoupled data for use in future simulations are defined in the Decoupling dialogue in 

the Hydrodynamic Module, see Figure 4.44. 

 

 
 
Figure 4.44 MIKE 21 Flow Model FM: Decoupling specifications 

 

The decoupled data are generated and saved every 2 minutes, i.e. with a time step 

frequency of 2. The data files and specification file are defined by default names. 

 

4.5.2 Changed model specifications 

The results from Calibration 1 showed the turbidity values to be far too dominated by the 

tidal process. This could be due to many factors, e.g. the mud settling too slowly or the 

calculation of the erosion and deposition rates being underestimated. 

 

Furthermore, as the results in the first calibration showed a general trend towards a 

decrease in turbidity, a number of parameters have been changed in Calibration 2. All 

parameters have been modified in order to increase the moveability of mud to and from 

the bed. 

 

The set-up for Calibration 2 is similar to Calibration 1 with the exception of the parameters 

listed in Table 4.4. 
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Table 4.4 Changed parameters in Calibration 2 

 

Parameter Value 

HD: Maximum time step 30 s 

HD: Decoupling Time step interval: 2 

Ho_DecouplingFlux.dfsu 

Ho_DecouplingArea.dfsu 

Ho_Decoupled.m21fm 

MT: Settling Settling velocity coefficient: 10 m/s 

MT: Erosion (Soft mud) Critical shear stress: 0.08 N/m2 

MT: Deposition Critical shear stress: 0.04 N/m2 

MT: Include waves Shear stress formulation: Max. Fredsøe 

Result Files hd.dfsu       esbjerg_hd.dfs0      rcm9_hd.dfs0    

mt.dfsu       rcm9_mt.dfs0 

 

4.5.3 Model results compared with measured values 

The resulting turbidity at station RCM9 is shown in Figure 4.45. 

 

 
 
Figure 4.45 Comparison of measurements and model output data of turbidity at monitoring station 

RCM9, Calibration 2 

 

The simulated results are more comparable with the measured turbidity values, but there 

is still room for improvement. Generally, when calibrating you should only change one 

single parameter at a time and track the changes in a log. 
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4.6 Model Calibration 3 

4.6.1 Decoupled model set-up 

The decoupled model data were saved during the simulation of Calibration 2. When using 

a decoupled set-up you cannot change the basic parameters in the Time, Domain or 

Hydrodynamic dialogues, but you are allowed to change the parameters in the Mud 

Transport Module. 

 

4.6.2 Changed model specifications 

The good results in the end of Calibration 2 indicate that the basic physical processes of 

the sediments (settling and resuspension) now have reasonable parameters. In this case 

the problem is that too little sediment is transported to the monitoring station from 

neighbouring points. Therefore, Calibration 3 will concern the initial conditions only and 

not the parameters for settling and resuspension. In this phase it is often a good practice 

to run a sensitivity analysis for the parameters that you want to change in your calibration.  

 

If you run 3 sensitivity simulations as follows, you will find that the initial conditions of 

Fraction 1 is very important in the simulation results, Layer 1 thickness is not so 

important, and Layer 2 has some effect (a longer lasting effect, however): 

 

1. Fraction 1 set to zero 

2. Layer 1 thickness set to zero 

3. Layer 2 thickness set to zero 

For Calibration 3 we want to keep the good results in the start of the simulation, but 

increase the simulated concentrations in the end. Therefore, the initial conditions of Layer 

2 has been changed by adding 1 mm to the layer thickness in the entire area in order to 

increase the amount of material transported to the area of interest. 

 

Try replacing the file for the initial conditions in Calibration 1 (mt_version1.dfs2) with 

mt_version2.dfs2 and run the set-up.  

 

4.6.3 Model results compared with measured values 

The resulting turbidity at station RCM9 is shown in Figure 4.46. Now the model output 

turbidity is increased, but it does not improve the results. Changing the initial conditions in 

a 2D varying map is difficult, because the exercise is to guess the distribution at a 

previous time step, which is a difficult task. In this situation you should look at the results 

in an area series, see Figure 4.47. 

 

Try to calibrate further by changing the initial conditions more. For each calibration 

simulation compare the results with the measurements. You should only change a single 

parameter at a time and track the changes in a log. Also be careful not to give values 

outside a realistic range.  

 

Please note the way the folders are organised in the example: You can simply copy the 

Calibration_3 folder and rename it to Calibration_4. This way the Plot Composer file will 

also work for the new calibration simulation, because the path to the files in the Plot 

Composer file is relative to the present folder. If you are making many simulations this 

trick can save a lot of time. 
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Figure 4.46 Comparison of measurements and model output of turbidity at monitoring station 

RCM9, Calibration 3 

 

 

 
 
Figure 4.47 Area Series of output from the MIKE 21 Flow Model FM Mud Transport Module 
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4.7 Including Transport of Sand 

In the channels and other deeper areas in Ho Bay, a large fraction of the bed material is 

sand. The transport of the sand can be included in the MT model for Ho developed in the 

previous subsections. The needed steps to do this are explained in the present section.  

 

4.7.1 Generating the transport tables 

In the present subsection we show how to generate sediment tables for the MT model. In 

case you want to skip this step, the generated tables are provided in  

 

.\HoBay\Data\Sediment_tables 

 

First, we will create the sediment transport tables needed to complete the calculation.  

The transport tables are created using the “Generation of Q3D Sediment Tables” tool 

(Figure 4-49) which is part of the MIKE 21 Toolbox (see Figure 4-48).  

 

 
 
Figure 4-48: Location of the MIKE21 Toolbox.  
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Figure 4-49: Location of the “Generation of Q3D Sediment Tables” tool.  

 

Create a new sediment table and give the setup a name:  
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Click “Next” and select the “Near-bed transport ” option: 
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Click next and select “Empirical bed concentration”: 

 

 
 

Click next and keep the default settings on the next page: 
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Chose the table resolution and dimensions to cover the conditions experienced in the 

domain in the simulation period: 

 

 
 

Choose the file name and location. Note that only the *.lon file is named, the other 5 

tables are given the same name in the same location but with their own extension.  
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Review the setup and click Execute: 

 

 
 

After a little while the estimated time remaining is shown: 

 

 
 
Figure 4-50: Progress visualisation window  

 

While the tables are generated we can proceed to setting up the parameters in the MT 

module.  

4.7.2 Setup of Sand Fraction in MT Model 

Our starting point is the setup used for Calibration found here: 

 

.\HoBay\Calibration_1\ho.m21fm 

 

Save this setup as a new name e.g. ho_with_sand.m21fm 

 

The setup including sand as described in the following is provided in  

 

HoBay\Sand_transport\ho_with_sand.m21fm 
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Fractions and layers 

First an additional fraction representing the sand is added on the parameter selection 

page. An additional layer is also added. This layer is used to add sand in the areas where 

there is no mud in layer 1 and layer 2.  

 

 
 
Figure 4-51: Specifying parameters 

 

Next the new fraction 2 is made into a sand fraction on the “Sand Fraction” page in the 

Water Column section. The formulation is selected to be “Near-bed load and suspended 

load” and Fraction 2 is chosen to be a sand fraction. Next the generated sediment 

transport table is chosen with the file selector.  
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Figure 4-52: Specifying inclusion of sand fractions 

 
The density of the layer 1 is changed to 1500 kg/m3. This is done to avoid unreasonable 
bed level changes when sand is eroded from layer three and deposited in layer 1. The 
density of the layers is constant in time in the model (i.e., the density does not change 
with sand content) so the user has to be careful when choosing the density of the top 
layer in situations with combined sand and mud. Note that the density only affects the 
thickness of the layer, the eroded and deposited mass which is the conserved variable in 
the model is unaffected by the density.  
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Figure 4-53: Specifying density in layer 1 

 

The density of layer 2 and 3 is also set to 1500 kg/m3. 

 

 
 
Figure 4-54: Specifying density, layer 3 
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The properties of the sand are given on the sediment properties tab (only visible when 

“Near-bed load and suspended load” is chosen) 

 

 
 
Figure 4-55: Specifying sediment properties 
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Initial conditions 

The initial conditions for the suspended sediment concentration of the sand fraction is set 

to 0:  

 

 
 
Figure 4-56: Specifying initial concentration for sand fraction 

 

Next, the initial conditions for the bed layers in the model are set. First the bed thickness 

for layer 1 is set. The density of layer 1 was changed from 180 kg/m3 to 1500kg/m3, thus 

to have the same mass of material in layer 1 as before, we need to reduce the initial 

thickness of layer 1 by a factor = 180/1500 in the initial conditions. Likewise, the density of 

layer 2 was changed from 300 to 1500 kg/m3, so the thickness of layer 2 should be 

reduced with a factor of 300/1500. This has already been done in the file named 

“mt_version1_w_sand.dfs2” which can be used as initial conditions for the thickness of 

layer 1 and layer 2.  
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For layer 3 we will assume a constant thickness of 1 m in the entire domain: 

 

 
 
Figure 4-57: Specifying initial layer thickness for sand fraction 

 

For the fraction distribution, in layer 1 and 2 we assume that we initially have 100 % mud, 

while in layer 3 we have 100 % sand: 

 

 
 
Figure 4-58: Specifying distribution of sediment fractions 
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Morphology 

When including sand it is often a good idea to include the morphology in the calculations.  

 

 
 
Figure 4-59: Specifying inclusion of morphology 

 
 

Outputs 

On the output section “near-bed load transport” outputs can be chosen. Note that these 

outputs only contain the near-bed transport of sand, the suspended transport due to 

advection of suspended sediment can be calculated by multiplying the SSC with the 

current speed and water depth. The bed level is also added since we are including the 

dynamic morphology in the calculation.  
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Figure 4-60: Specifying output items 

 

 

A discharge output is also selected, this will contain both the near-bed load and the 

suspended load sand transport: 

 

 
 
Figure 4-61: Specifying discharge output 
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4.7.3 Results 

The files used to make the plots shown in this section are found in 

 

.\HoBay\Sand_transport\Plots 

 

Below is shown the accumulated near-bed transport vectors on top of the bed level. It is 

seen that the transport of sand mainly occurs in the tidal channels.  

 

 
 
Figure 4-62: Result: Accumulated near bed transport vectors 

 

The discharge of sand across the northern tidal channel (where the discharge output is 

located) is shown below. It is seen that the net transport during this period is out of the 

channel, but this net transport is the result of large transport both in and out of the 

channels. Note that the 430 M kg which is the accumulated discharge is the same as 

around 16200 m3 of solid volume sand, assuming a density of 2650 kg/m3.  

 

 
 
Figure 4-63: Result for fraction 2: Discharge rates (black line), Accumulated discharge (blue line) 

 
The modelled and measured turbidity at RCM 9 is shown in the figure below. It is noted 
that the inclusion of sand in the model has not influenced the calibration of the ssc which 
is the same as for Calibration 1, this is because we are using the same settings regarding 
the mud fraction.  
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Figure 4-64: Result: turbidity for fraction 1 (mud) 
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